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1. Introduction

The OptiPaint™ system is a combination of hardware and software that allows you to use brushes and other traditional

artists’ tools to paint into popular Windows programs such as Adobe Photoshop and Corel Painter. It does so by means
of patented optical and electronic hardware working in conjunction with a Photoshop plugin. This guide describes how
to set up and use that hardware and plugin software. Please read the entire guide before using the OptiPaint system. A
copy of this guide is included on the OptiPaint Siftware CD that came with your system and can also be found on your

Programs menu after installing the software.

The OptiPaint system may be used with a wide variety of programs that accept Photoshop plugins, referred to as plugin
“hosts”. This manual does not provide detailed information about how to use various plugin hosts. Your best source of
information for that would be the manual that came with your plugin host software or the provider of that software.

1.1. Precautions

Be sure to follow all instructions, cautions, and warnings found within this manual. Failure to do so could cause
damage to the OptiPaint system or your computer, and could also void your warranty.

Please note that the OptiPaint system is typically used in conjunction with water. In order to ensure that that
water does not damage your computer or other electronic devices, you must take steps to ensure that water does
not come in contact with such devices. Also, the OptiPaint hardware itself is not submersible. While water may
be used on its glass painting surface, water should not be allowed to come into contact with the connectors or
panel on the back of the device. Furthermore, if you or your clothing become wet while using the OptiPaint
system, you should dry off before touching other electrical devices, in order to prevent a possible shock hazard.
It is recommended that any electrical equipment used near water be plugged into an outlet equipped with a
ground-fault circuit interrupter (GFCI), in order to minimize the risk of electric shock. Should any water
accidentally enter the OptiPaint system, your computer, or other electronic devices, turn those devices off
immediately and contact authorized repair personnel.

The OptiPaint hardware should not be used in dusty environments, nor should it be exposed to sunlight or
extremes of heat or cold, any of which may damage the hardware.

Only the power adapter that came with the OptiPaint system should be plugged into the OptiPaint hardware.
Other power adapters may damage the OptiPaint hardware or cause a fire hazard and will void your warranty.

Do not open the OptiPaint hardware enclosure. There are no user-serviceable parts inside and doing so will also
void your warranty.

In order to avoid damaging the active painting surface, do not place sharp, abrasive, or heavy objects on it. Do
not use abrasive cleaners such as scouring powders or pads on the painting surface, which may also cause

permanent damage to that surface.

Avoid shock or vibration to the OptiPaint hardware. Hitting or dropping it may cause permanent damage to
the optics or electronics inside.

When not using the OptiPaint hardware for long periods of time, disconnect its USB cable from the PC and
remove its power adapter from the AC outlet.
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2. Installation

Please note that the software consists of two parts: the OptiPaint plugin and the driver for the camera inside the
OptiPaint system. The plugin installer will automatically launch the installer for the camera driver. However, you must
complete the installation for both components, accepting the separate license agreements for each one, in order to be
able to use the OptiPaint system.
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2.1. Software installation

Insert the OptiPaint Software CD. If the installer doesn’t auto-run after a few moments, navigate to the file
‘setup.exe’ in the root folder of the CD, and double-click on it.

On the OptiPaint Plugin Setup Wizard, click Next.

On the License Agreement page, read the agreement, select “I Agree”, and click Next.

On the Select Installation folder page, browse to the folder where your plugin host expects to find plugins, e.g.
‘C:\Program Files\Adobe\Adobe Photoshop CS2\Plug-Ins’. (If you don’t know where your host expects to find
plugins, just accept the default location.) Click Next twice.

On the Camera Software Setup Wizard, click Next.

On the License Agreement page, read the agreement, click “I accept the agreement”, and click Next four times
(accepting the default locations).

On the Ready to Install page, click Install.

When the camera installation completes, leave “Create a desktop icon” checked and click Finish.

On the OptiPaint Plugin Finish Installation page, click Close.

2.2. Hardware installation

Plug the USB cable into the connector at the back of the OptiPaint hardware and into an available USB 2.0 port on
your computer.

When the Found New Hardware Wizard appears, select “No, not this time” and click Next.

Leave “Install the software automatically” selected and click Next.

When it finds the “SMX-M7x Series USB2.0 Camera” click Next. (It doesn’t matter which of the two instances
shown is highlighted).

When you see the notice that this software has not passed Windows Logo testing, click Continue Anyway.
When the Wizard completes, click Finish.

Plug the power adapter into the connector at the back of the OptiPaint hardware and then into a 110VAC outlet.
Press the power switch on the back of the OptiPaint hardware to the (so that the ‘I’ symbol is depressed). You
should see the red LEDs light up at the front of it.

2.3. Hardware verification

In order to verify that the OptiPaint hardware has been installed correctly, please complete the following steps:

1.

2.
3.

Double-click the “SMX-M7x USB2.0 Camera” icon on your desktop. When the SMX-M7x camera software
opens, click the P> icon (or press F5) to start live video.

Click the “All” slider in the Gain section and drag it up until you see something in the video image.

Wet the brush that came with your system and touch it to the middle of the translucent glass painting surface at the
front of the OptiPaint hardware. You should see an image of your brush tip in the Video window. (It is normal for
this image to be upside down and vertically compressed.) If you do not, make sure you’ve followed the hardware
installation steps above (section 2.2). If that does not resolve the problem, call Light Strokes support at (415) 272-
7506.

Click File > Exit to close the camera utility.

4-



3. Setup

3.1. Plugin host setup

In order to use the OptiPaint system with your plugin host software (e.g. Photoshop, Painter, etc.) you must configure
that host to recognize the OptiPaint plugin. Plugin hosts usually have a folder where they expect to find plugins and
many also allow you to specify additional plugin folders. Some hosts also require that you enable plugins.

If at step 4 of the software installation above you accepted the default location for the OptiPaint plugin, you can now
manually move the file ‘LightStrokes.8bf” from your ‘\Program Files\Light Strokes\OptiPaint’ folder to the plugin
folder for your host software. For example, for Photoshop CS2, the usual location would be ‘\Program
Files\Adobe\Adobe Photoshop CS2\Plug-Ins’ and for Paint Shop Pro X it would be ‘\Program Files\Corel\Corel Paint
Shop Pro X\Pluglns’. Alternatively, for plugin hosts that allow you to specify additional plugin folders, you can use
that facility to point your host at the ‘\Program Files\Light Strokes\OptiPaint’ folder.

Make sure that plugins are enabled in your host software. For example, in Paint Shop Pro X, you would do that by
selecting File > Preferences > File Locations.... Then under “File types”, select “Plug-ins”, check the box that says
“Enable plug-ins...” and click OK.

3.2. Plugin setup verification

To verify that the OptiPaint plugin is set up correctly, please complete the following steps:

1. Start your plugin host software.

2. Open an existing 24-bit color (8-bit RGB) image or create a new one, up to 800x600 pixels in size.

3. Select Light Strokes > OptiPaint from the plugin filter menu (e.g. “Filter” for PhotoShop CS2 or “Effects >
Plugins” for Paint Shop Pro X). If it doesn’t appear on that menu, make sure you’ve completed the host setup
steps above (section 3.1).

4. After a moment, the OptiPaint plugin main screen should appear. If it does not, call Light Strokes support
at (415) 272-7506.

3.3. Hardware setup

In order to use the OptiPaint system most effectively, it should be located at a comfortable height and such that bright
room lights don’t interfere with its operation. The OptiPaint painting surface should be located at or below the height
of your elbow. A low table such as the 30" Personal Table from Lifetime Products, with a minimum height of 21” (see
www.buylifetime.com/detail.aspx?ID=255 or www.amazon.com/Lifetime-28241-30-Inch-Personal-White-
Granite/dp/BO006D50RO), can put the OptiPaint at a comfortable height.

To make sure that bright room lights don’t interfere with the system, first open up the OptiPaint plugin as described in
section 3.2 above, using a solid white 800x600 image at step 2. Make sure the painting surface is clean and dry and
that the red LEDs are on. If you see a flashing gray or black rectangle on the OptiPaint plugin’s main screen, it means
that some bright light is interfering with the system. (It is important that the painting surface be clean and dry at this
point, since water droplets, water residue, or painting tools on that surface can also make that flashing rectangle
appear.) Try rotating the OptiPaint hardware around a vertical axis to find a position where the flashing rectangle goes
away. The system is least sensitive to lights that come from either side of the painting surface, but sunlight should not
be allowed to fall on it from any angle. If you can’t find a usable position that doesn’t show a flashing rectangle, you
may need to turn off or dim some of your room lighting. Once you’ve found a position where no flashing rectangle
appears, you're ready to proceed. If there is still a small flashing rectangle, it may be possible to eliminate it by
adjusting the Optipaint settings as described below in section 4.

Any brushes or other tools you use to paint with the OptiPaint system must be wet (or the painting surface itself must
be) in order for the system to be sensitive to them. The use of water near electrical equipment requires care in
order to avoid possible equipment damage or shock hazard. Make sure that any water you’ll be using with the
OptiPaint system is located where it cannot be accidentally spilled onto your computer or any other electrical
devices.

5.



To keep the system from responding to droplets of water itself, a wetting agent may be added to the water to reduce its
tendency to bead up on the painting surface. A sample of Veggie Wash is included with your system for that purpose
(more can be purchased at www.veggie-wash.com). A drop or two of Veggie Wash in 8 fl. oz. of water should be
sufficient, though you may need to add more if your water is particularly “hard”. If you use too much, you may get
foam on the painting surface, which can also cause painting in unwanted areas. In that case, simply dilute the solution
with more water. Edwal LFN Low Foam Wetting Agent (www.bhphotovideo.com/sitem/sku=16726) may be used
instead of Veggie Wash for the same purpose.

Almost any light-colored object can be used to paint with the OptiPaint system. A good online source of brushes is
Dick Blick Art Materials (www.dickblick.com). A sample of one of their Holbein White Hair Bamboo Brushes
(www.dickblick.com/zz054/02) is included with your system. Their synthetic-fiber Niji Waterbrushes
(www.dickblick.com/zz051/33) are also interesting in that they include their own water reservoir. You may also want
to try natural and synthetic sponges, plastic or foam shapes or styli, textured or patterned cloth, string and yarn, and
even your fingers and hands.

You should not use sharp, abrasive, metallic, or ceramic objects that might scratch the glass painting surface. Scratches
could reduce the sensitivity of the system or make it completely unusable. Brushes with metal ferrules may be used as
long as the metal part isn't brought into contact with the painting surface. If you’re finger painting, make sure that rings
and other jewelry don’t come in contact with that surface. If the water you’re using becomes dirty, replace it with fresh
water.

You also should not use crayons, markers, paints, erasers, or any other object that might leave a residue on the painting
surface.
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4. Using the OptiPaint™ system

4.1. Main screen

Start/Stop

Most of your time using the OptiPaint system will be spent at its main screen shown above. When you first launch the
plugin, if you touch a wet drawing tool to the active part of the painting surface, you’ll see a non-destructive video
overlay which shows the shape and position of that tool on the drawing surface as above. The rectangle that just
includes those parts of the tool bright enough to cause painting will be shown, though the darker parts of that rectangle
will not cause painting. When you click the Start button, painting will begin immediately. Painting will continue as
long as something light-colored is in contact with the painting surface. To stop painting, simply lift the tool; to
continue painting again, simply lower it to the painting surface again. If you want to see where you’re going to paint
again, before you actually start painting there, click the Stop button (the same button that was previously labeled
“Start”), and the video overlay will return. By clicking Stop, you can also wipe away water drops, brush fibers, etc.
from the painting surface without your wiping action itself causing inadvertent painting. Note that it’s not necessary to
click Stop before changing colors or painting functions or using different physical tools. Once you’ve gotten
accustomed to the system, you’ll probably find that you hardly ever have to click the Stop button.

OK and Cancel

You can click OK at any time to return to your plugin host with your latest changes incorporated into the image. If you
click Cancel instead, you’ll return to the host without those changes being made. Most hosts have an undo function
that will also let you undo the changes even though you clicked OK. You can go back to the OptiPaint plugin as often
as you’d like to continue making changes to the image. The hosts’s undo/redo functions will then typically let you step
forward and back through this history of changes from each plugin session. In section 4.2 below you’ll see how within
the OptiPaint plugin itself it’s possible to undo your painting to a specific frame within a painted stroke.

Painting functions
At any time you may select any one of the three basic painting functions: Solid, Texture, and Blur. Each of these is
further controlled by the setting of the Opacity slider.

When Solid is selected, anything you paint will show up in the Foreground color. That color is the same as your plugin
hosts’s foreground color at the time you launched the plugin. You can change that color at any time within the
OptiPaint plugin itself by clicking on the color swatch below the word Foreground and selecting a new one from the
color picker that pops up. (Note however that the new color isn’t saved once you return to your plugin host by clicking
OK or Cancel on the OptiPaint plugin main screen.) The actual color you see when painting is also affected by the
setting of the Opacity slider. When it is less than 100%, the colors underneath where you’re painting will show
through to some degree. If you have the opacity set quite low, you may also notice that the color is very faint if you
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move the brush or other tool quickly, but deepens the longer you hold it in one place (much like the behavior of water
colors). That’s because the color placed earlier is showing through the same color placed later. Also, if your painting
tool is not very bright, you may see other colors showing through even when the opacity is at 100%. That’s because
with the Solid painting function, the brightness at each pixel of the tool is used to control how much of the Foreground
color is laid down. In that way, painted strokes are automatically anti-aliased, since the edges of the images of the tool
are darker than their interiors.

When Texture is selected, anything you paint will show up in some combination of the Foreground color and the
Texture color. The Texture color can also be changed at any time by clicking on the color swatch under the word
Texture. Unlike the Foreground color, it will stay the same until you change it again, even between separate sessions
with the OptiPaint plugin. The brightest parts of the images of painting tools will show up in the Foreground color, the
darkest parts will be in the Texture color, and intermediate parts will show up in an intermediate color. Because of the
way the Texture function combines the individual frames of a painted stroke, the edges between those frames stands
out, resulting in the texture you see. Unlike the Solid function, these edges are not anti-aliased, so the raw resolution of
the image will be apparent, especially when the Opacity is near 100%. Again, if the Opacity is set lower, more of the
underlying image will show through newly painted strokes.

When Blur is selected, painted strokes will simply blur the underlying image. The degree of blurring is controlled by
the Opacity slider, so unless it’s set near 100%, and unless the part of the image being blurred contains some fairly
sharp edges to start with, its effects may not be very noticeable. But it is also cumulative, i.e. the more you paint over a
given area, the more blurring will occur.

Clear

At any time, you can clear the image to the Background color by clicking the Clear button. The Background color (like
the foreground color) initially comes from the current setting in your plugin host. You can change the Background
color within the plugin by clicking on the color swatch below the word Background, but (again like the foreground
color) this new color will not be saved when you click OK or Cancel to return to your plugin host.

Setup and Undo
The Setup and Undo buttons simply call up the Setup screen and Undo control, described below. Until something has
actually been painted, the Undo button will be grayed out.



4.2. Undo control

Undo Control

Click Undo on the main screen to open the Undo control, shown above. You can drag this control to any convenient
location on your screen. It allows you to move backwards and forwards through your painting history. In this way, if
you paint something that you then decide was a mistake, you can undo to a point just before you made that mistake.
Move the slider and release it (or click to either side of its pointer) until you find a point near where you want to undo
to. You can then use the «— and — buttons to step backwards and forwards, a frame at a time, until you reach the exact
point that you want. Then click OK to return to the main screen for more painting (or Cancel if you decide you don’t
want to undo anything after all). Painting will have been automatically stopped while you were undoing, so once you
return to the main screen you’ll need to click Start again to resume painting.

Note that the Undo control only works for your current plugin session, i.e. you can’t undo to a point before you last
launched the OptiPaint plugin. Also, the amount of history you can undo is limited by the amount of RAM you’ve
reserved for the Undo buffer via the Setup screen (see section 4.3 below). The default setting of only IMB won’t allow
you to undo much history at all, so you’ll probably want to set it to a higher value, subject to the amount of RAM you
have available.

The Undo control also allows you to save your painting history (subject to the same limits as above) as a series of still
images which can then be turned into a movie. To do so, move the slider and/or use the arrow buttons to move to the
point in the painting history that you want to be the final saved image, then click Save. On the Browse For Folder
dialog, browse to the folder in which you wish to save these images. You can also click the Make New Folder button
and type in a name for a new folder. When you click OK, the images will then be saved in the selected folder (this may
take some time if your Undo Buffer contains a large number of frames).

You can use a variety of third-party tools to turn those saved images into a movie. The steps for doing so using

Apple’s QuickTime Pro are as follows:

1. Launch QuickTime Pro.

2. Select File > Open Image Sequence...

3. Navigate to the folder in which you saved the undo history and double-click on any of the images there.

4. Once your movie opens up (which again may take a considerable time if there were a large number of frames), you
can click the play button to watch it and File > Save to save it.

9.



4.3. Setup screen

0 | Brghnsss
¥ Threshalds
32 | Contrast 100 | Solid
i 1
0333 | Gamma 100 | Texture
¥ 1]
Centering
Use host
G| P M cotor iker
15| ¥ Offset
Undlo
100 Buffer size (MB)
Saved histary
JPG || File format
1 Skip frames
10000 | Maxtrames
Restare Defoults

Click Setup on the main screen to open the setup screen, shown above. It allows you to set a variety of parameters that
control the operation of the OptiPaint system. Each of the controls that has a slider also lets you specify a numerical
value by typing it in. Feel free to experiment with all the controls on this dialog — you can always revert to the original
factory settings by clicking the Restore Defaults button. To keep your new settings, click OK. To revert to the
settings in effect before you opened the setup screen, just click Cancel.

Brightness, Contrast, and Gamma

The Brightness, Contrast, and Gamma controls let you adjust the camera inside the OptiPaint system, and thus the
sensitivity of the system. Their effects can be seen in the live video window to their left. You may want to place a tool
on the painting surface while adjusting these controls, in order to see their effects. Bear in mind though that the most
pleasing video image here doesn’t necessarily lead to the best results when painting. The default settings were chosen
empirically to work well for most tools, but you may prefer other settings

By increasing the Brightness, the system can be made more sensitive to darker tools. However, it will also increase the
sensitivity to background illumination, so it’s generally advisable to keep the Brightness setting relatively low.

By increasing the Contrast, the difference between the brighter and darker parts of a drawing tool is accentuated. It
should normally be kept near the upper middle of its range. If it set too low, the system will tend to be overly sensitive
to background illumination and not sensitive enough to painting tools. If it is set too high, strokes painted with the
Solid function will be not be anti-aliased very well and those painted with the Texture function will not show many
mid-tones.

The Gamma control lets you adjust how contrast varies between the darker and lighter parts of the camera’s image.
High Gamma settings enhance contrast in the brighter regions and reduce it in the darker ones, while low gamma
settings have the opposite effect. A low Gamma setting works well when the Brightness is also set low.

The Brightness, Contrast, and Gamma controls, in concert with the threshold controls described below, may be used to
compensate somewhat for bright room lighting that increases the level of background illumination. However, doing so
will also tend to reduce the sensitivity of the system to painting tools. So whenever possible, it’s better to adjust the
orientation of the OptiPaint hardware and the room lighting to minimize that background level, as described in section
3.3 above.

Thresholds

The Threshold sliders let you set the darkest part of the camera’s image of a painting tool that will cause painting. This
can be set independently for the Solid and Texture painting functions (the Blur function uses the same threshold as
whichever other painting function, Solid or Texture, was last selected). It should normally be set at the lowest level
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that doesn’t allow background illumination to cause painting in areas where there’s no tool in contact with the painting
surface. If it’s set too high, you’ll have trouble painting with even the brightest tools.

The effect of these thresholds is not visible on the setup screen itself. To gauge their effects before actually painting,
return to the main screen, click Stop (if painting wasn’t already stopped), and select the painting function (Solid or
Texture) whose threshold you’re adjusting. If you touch a wet tool to the painting surface, you should see a flashing
rectangle that just encloses the image of that tool. If that rectangle encloses a larger area, it means the threshold is set
too low (assuming the painting surface is otherwise clean and there is no interference from room lights). If the
rectangle doesn’t show the entire tool, it means the threshold is set too high.

Thresholds near the middle of the range generally work well. While setting the threshold higher can compensate
somewhat for excessive room illumination, it also reduces the sensitivity of the system and its dynamic range.

Centering
The X Offset and Y Offset controls enable you to adjust where on the painting surface the image is centered. Their
effects are visible in the live video window to their left. These should generally be left at their original factory settings.

Color Picker

Leave “Use host color picker” checked in order to use your plugin host’s color picker when you click on a color
swatch to adjust the Foreground, Texture, or Background colors. If you uncheck that box, the standard Windows color
picker will be used instead.

Undo controls

The controls in the Undo section allow you to configure how the Undo control works. In the Buffer size field, enter
the amount of memory (in megabytes) that you want to reserve for the undo history. It’s important to set this size
before you begin painting something that you’d like to undo — any changes you make to this value will cause your
current undo history to be erased as soon as you click OK on the setup screen. The larger this number, the more
history you’ll be able to save and undo. For moderately sized painting tools, 100MB of buffer will hold about 30
seconds of painted history. Larger tools will require a larger buffer size to hold the same amount of history, and
smaller tools will require less. Note that time you spend selecting colors, etc. when you’re not actually painting,
doesn’t use up any buffer space.

The Saved history controls affect only how the undo history is saved as a series of images when you click Save on the
Undo control. They do not affect how much RAM is used to hold the undo history. Use the File format control to
select whether the history is saved as a series of BMP, GIF, JPEG, or PNG images.

Set the Skip frames value to adjust how many frames (if any) are skipped when saving the image series. For example,
if the Undo history consisted of 100 frames but the Skip frames value is set to 1, then only every other frame (50
altogether) will be saved as a separate image when you click Save on the Undo control. A value of 1 usually works
well for creating movies since the OptiPaint system typically captures frames at about 60/sec, while movies are
typically played back at only 30 frames/sec.

Set the Max frames value to limit the maximum number of images that will be saved.
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4.4. Interaction with plugin host

The OptiPaint plugin’s capabilities can leverage those of your plugin host software in many ways. Below are some
examples. Bear in mind that the OptiPaint plugin only works on 24-bit color (8-bit RGB) bitmaps.

Working with selections

If you’ve selected a portion of your image before launching the OptiPaint plugin, then it will only operate on the
selected region. Note that the image on the OptiPaint plugin’s main screen will then show the smallest rectangle that
encompasses the selection. When you paint on that image, it will appear that you can paint on parts of the image that
weren’t selected but that happen to fall within that bounding rectangle. However, when you click OK on the plugin to
return to your host software, only the selected regions will be affected.

In this way, it’s also possible to work on images larger than 800x600, as long as you select a portion of it no larger than
that before launching the OptiPaint plugin. If the image (or selection) is larger than 800x600, then the plugin will only
operate on the first 800x600 pixels in the upper left corner of the image (or selection).

Working with layers

The OptiPaint plugin (as all Photoshop plugins) can only work on a single layer at a time. If that layer contains
transparent regions, those regions will be shown in gray in the OptiPaint plugin. Again, while it then appears that you
can paint on those areas, when you click OK to return to your host software, the transparent regions will not be
affected. The OptiPaint plugin will also preserve the level of transparency of pixels in the original layer that were only
partially transparent (such as the edges of anti-aliased shapes or those drawn with opacity less than 100%).

Working with vector graphics

The OptiPaint plugin can only work on bitmapped (rasterized) images. If you’re working with a vector graphic, e.g. in
lustrator, you will need to rasterize it before using the OptiPaint plugin. If you’re working on a text layer in
Photoshop when you try to launch the OptiPaint plugin, you’ll be asked if you want to rasterize the layer before
proceeding. Click OK in order to use the OptiPaint plugin on that layer.

-12-



5. Maintenance

5.1. Cleaning

The painting surface is glass and may be cleaned with a non-abrasive glass cleaner, such as Windex, on a soft clean
cloth. The OptiPaint enclosure may be cleaned with a mild detergent, such as dishwashing liquid, on a damp cloth. Do
not allow water or other liquids to penetrate the back panel of the enclosure.

5.2. Troubleshooting

The following table lists a number of possible symptoms you might encounter when using the OptiPaint system and
their possible causes and cures. The most likely cures for each symptom are listed first. If you encounter a problem
not listed here, or the proposed solution is not helpful, please contact OptiPaint technical support at (415) 272-7506 or

support@OptiPaint.com.

Symptom

Possible causes and cures

Painting happens even when no tool is
touching the painting surface

e  Make sure the painting surface is clean and free of brush fibers or
other debris.

e If your water has become cloudy, replace it with fresh clear water.

e [If water is beading up, use more wetting agent. If it’s foaming, use
less. (section 3.3).

e  Adjust the orientation of the OptiPaint system and/or the room
lighting. (section 3.3)

e  Adjust the Brightness, Contrast, Gamma, and Threshold settings.
(section 4.3)

Painting doesn’t happen even though a tool
is touching the painting surface

e  Make sure the red LEDs are on. The power adapter must be
plugged into a powered AC outlet and into the back of the
OptiPaint device. The power switch must also be in the “on”
position (‘I” symbol depressed).

e The tool must be white or light-colored. The OptiPaint system is
not sensitive to dark-colored objects.

e  The tool must be wet.

e The tool must be within the active part of the painting surface.
There’s an inactive margin about 1” wide around the active
painting area.

e  Adjust the Brightness, Contrast, Gamma, and Threshold settings.
(section 4.3)

“Light Strokes” does not appear on the
host’s plugin menu

Make sure you’ve placed the file ‘LSPlugin.8bf” in the host software’s
plugin folder (or set up your host software to look in the folder where
‘LSPlugin.8bf’ is located) and that plugins are enabled within your host
software. (section 3.1)

“Light Strokes” is grayed out on the host’s
plugin menu

No 24-bit color image is open or none is selected. If the color depth of
the currently selected image is not 24 bits/pixel (8-bit RGB), use the
host’s color depth management functions to change it to that.

Painted strokes show up as a series of spots

If you’re making very fast strokes, this is a normal consequence of the
fact that the camera inside the OptiPaint system is capturing images at a
maximum of 60 frames/sec. You may also see this effect with
somewhat slower strokes if you’re using very large tools that cover
most of the painting surface, or if your PC is relatively slow, or if you
have other programs running that are using some of the PC’s
bandwidth. In all of those cases, the frame capture rate may be only
30/sec or less.
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Error message "OptiPaint hardware not
found!"

e  Make sure the hardware has been installed. (section 2.2)

e  Make sure the USB cable is plugged into both the OptiPaint
hardware and the PC.

e  Try restarting the PC.

Error message "DLL not found!”

Move the file ‘SMXM7X.dII’ from the folder
‘C:\Program Files\Sumix\SMX-M7x USB2.0 Camera\APT’
to your \WINDOWS\system32’ folder.

Error message during installation “"Could
not find SMXM7X.dll"”

The default location for the camera driver was not used during the
installation. Locate the file ‘SMXM7X.dIl" in the “\APT’ subfolder of
the folder you selected during the camera installation and move it to
your \WINDOW S S\system32’ folder.

Empty video (no input)

This happens sometimes when the PC returns from Standby, especially
if the plugin host was running when Standby was entered. Solution:
with the OptiPaint plugin not running, unplug the OptiPaint USB cable
and plug it back in. Alternatively, do a system restart.

Red LEDs are not on

Make sure the power adapter is plugged into a powered AC outlet and
to the back of the OptiPaint device. Make sure the power switch is in
the “on” position (‘I symbol is depressed).

Undo sometimes gives incorrect results

This is a known limitation when the screen has been cleared more than
once within a single session. In those cases, you can only undo up to
the second to last screen clear, and attempting to undo beyond that
yields incorrect results. This behavior will be fixed in a later release.

Random lines are painted on the image at
random times

This is most likely due to interference with the OptiPaint’s camera
driver from some other software or hardware running on your system.
Exit all programs other than your plugin host and disable unused
hardware to isolate the source of the interference.

5.3. Uninstalling
Steps to uninstall the OptiPaint plugin:

1. Select Start > Control Panel > Add or Remove Programs.

2. Click on “OptiPaint Plugin”.
3. Click Remove and then Yes.

Steps to uninstall the camera driver:

1. Select Start > All Programs > Sumix > SMX-M7x USB2.0 Camera > Uninstall SMX-M7X USB2.0 Camera

Software.
2. Click Yes and then OK.
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5.4. Warranty

Limited Warranty

The OptiPaint software is licensed “as is.” Light Strokes warrants that the software will perform in substantial
accordance with this documentation, but otherwise makes no warranty with respect to its quality or performance.
Light Strokes warrants the OptiPaint hardware to be free from defects in materials and workmanship under normal use
and service for a period of one year from the date of original purchase. These warranties are limited to the original
purchaser and are not transferable.

Remedies

Light Strokes’ entire liability and your exclusive remedy for any such defect, shall be, at Light Strokes’ option, either
(a) return of the price paid or (b) repair or replacement of the hardware or software. Upon discovery of such a defect,
you should contact Light Strokes technical support for a Return Merchandise Authorization (RMA) number and
instructions for shipping the product to Light Strokes. You will be responsible for the cost of shipping the product to
Light Strokes and any loss or damage resulting from such shipment. Light Strokes will pay for return shipment of the
repaired or replaced product. Any repaired or replaced product will be warranted for the remainder of the original
warranty period or 30 days, whichever is longer. These remedies are void if failure of the hardware or software has
resulted from accident, abuse, misuse, negligence, or unauthorized modification or repair, or if it has been handled
other than in accordance with Light Strokes’ instructions.

Limitation of Liability

The warranties set forth in this agreement replace all other warranties. Light strokes expressly disclaims all other
warranties, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose
and noninfringement of third-party rights with respect to the documentation, software, and hardware. No Light Strokes
dealer, agent, or employee is authorized to make any modification, extension, or addition to this warranty. In no event
will Light Strokes or its suppliers be liable for any costs of procurement of substitute products or services, lost profits,
loss of information or data, or any other special, indirect, consequential, or incidental damages arising in any way out
of the sale of, use of, or inability to use any Light Strokes product or service, even if Light Strokes has been advised of
the possibility of such damages. In no case shall Light Strokes’ liability exceed the actual money paid for the products
at issue. Because some jurisdictions do not allow the limitation of implied warranties or liability for incidental,
consequential, special, or indirect damages, the above limitation may not always apply. The above limitations will not
apply in case of personal injury where and to the extent that applicable law requires such liability. This Limited
Warranty is governed by the laws of the United States of America and the state of California.

Warranty Service

To obtain Warranty service contact:
Light Strokes Technical Support
Phone: (415) 272-7506

E-mail: support@OptiPaint.com
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